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Important information for your
classroom amplification system
W  WARN ING

l Failure to follow the installation instructions shipped with your SMART product could result in
personal injury and damage to the product whichmay not be covered by your warranty.

l To reduce the risk of fire or electric shock, do not expose the SMART product to rain or
moisture.

l Ensure that any cables extending across the floor to your SMART product are properly
bundled andmarked to avoid a trip hazard.

l Don’t open or disassemble the SMART product. You risk electrical shock from the high
voltage inside the casing. Opening the casing also voids your warranty.

l If your SMART product requires replacement parts, make sure the service technician uses
replacement parts specified by SMART Technologies or parts with the same characteristics
as the original.

l To reduce the risk associated with leaking batteries:

o do not leave the battery in the product for an extended period

o do not heat, disassemble, or short the battery, or expose it to fire or high temperature

o avoid eye and skin contact if batteries have leaked

o dispose of exhausted batteries and product components in accordance with applicable
regulations

l Do not charge the battery with any power adapter other than the one supplied. Do not charge
other battery types in your SMART product with the supplied power adapter. Both of these
actions can cause damage to the product and can cause a fire or personal injury.

If the SMART product becomes excessively warm or emits an unusual smell while the
battery is recharging, immediately disconnect the power adapter from the power outlet and
turn the product off.
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l Do not use your SMART Audio™ classroom amplification system in a facility control system
or any other environment that requires extremely high reliability, or where the use of a
wireless device can cause interference. The product can interfere with other electronic
devices or cause them tomalfunction, or other wireless devices may interfere with the
product or cause it to malfunction. Where use is prohibited, turn off the product. SMART
Technologies does not accept any liability for damages.

l Ensure your ceiling or ceiling tiles are strong enough to support the ceiling-mounted product
components and use tethers if provided or required. Failure to securely install components
might lead to components falling which can cause personal injury and product damage that
may not be covered by your warranty. Refer to product documentation to find component
weights.

l Ensure the installation of your SMART product meets local building codes and regulations.

C   CAUT ION

l Avoid setting up and using the SMART product in an area with excessive levels of dust,
humidity and smoke.

l If your SMART product requires replacement parts, make sure the service technician uses
replacement parts specified by SMART Technologies or parts with the same characteristics
as the original.

l To reduce the risk of fire or electric shock, do not expose the SMART product to rain or
moisture.

l Make sure an electrical socket is near your SMART product and remains easily accessible
during use.

l Do not drop the portable components of your SMART product. Dropping your microphone
can damage it and void the warranty for that item.

l Do not place items other than your microphone in your microphone charging cradle. Items
can create an electrical short leading to product damage, fire or personal injury.

l When connecting product components, ensure cables are connected to correct locations.
Incorrectly connected components can result in product damage.

I M POR T A N T I N F ORMA T I ON F OR YOUR C L A SSROOM AMPL I F I C A T I ON SYST EM
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About your SMART Audio system
The SMART Audio system amplifies teacher and student voices, reducing teacher vocal strain and
ensuring that everyone can clearly hear what is being said from anywhere in the room. The systems
include a wireless microphone that either the teacher or students can use, a control unit that provides
a USB interface to the computer and a roommodule that combines an amplifier and an infrared
sensor.

The CAS-340model features seamless integration with SMART Notebook™ collaborative learning
software. Pressing the SMART Audio icon in SMART Notebook software brings up an intuitive user
interface that enables educators to control up to five audio inputs with the touch of a finger. Adjusting
the volume is quick and simple, saving valuable class time while maintaining lesson flow.
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With the CAS-360model, educators control the system settings by using the control dial and the LCD
screen on the wall-mounted control unit.

You can order either system with wall-mounted or ceiling-mounted speakers.

Choosing audio inputs
You can connect audio inputs from a variety of sources to your SMART Audio system, which
broadcasts them from your ceiling speakers or wall speakers.

Speaking into your microphone
When you speak into your SMART Audio systemmicrophone, your voice transmits by infrared signal
to the roommodule and is broadcast from the ceiling speakers or wall speakers. For more information
on speaking into themicrophone, see page 15.

Connecting audio input devices to your microphone
You can connect an audio input device, such as a portable audio player, directly to the 3.5mm jack on
your microphone. The audio input transmits by infrared signal to the roommodule and is then
broadcast from the ceiling speakers or wall speakers. For more information on connecting an audio
input device to themicrophone, see page 16.

Playing sound files from your connected computer
You can play sound or video files on your computer, and the sound file broadcasts from the ceiling
speakers or wall speakers.

Connecting audio input devices to your control unit
You can connect an audio input device, such as a CD player, DVD/Blu-ray™ player or VCR to the
wall-mounted control unit. The audio input then broadcasts from the ceiling speakers or wall
speakers. For more information, see page 10.

Connecting audio input devices to the External Control Panel (ECP)
You can connect an audio input device, such as a CD player, DVD/Blu-ray player or VCR to the ECP
of your SMART Board™ interactive whiteboard. The audio input then broadcasts from the ceiling
speakers or wall speakers. For more information, see page 10.

Paging over your SMARTAudio system
You can connect your existing paging system to the roommodule. The pages then broadcast from
your ceiling speakers or wall speakers. You can configure the system to reduce the volume of all

CHA PT ER 1
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other audio input devices when pages are broadcast.

Controlling audio inputs
You can control audio inputs broadcasting from your ceiling speakers or wall speakers from your
microphone or from SMART Audio software.

Controlling your SMARTAudio system with themicrophone
You can control audio inputs broadcasting from your ceiling speakers or wall speakers using your
microphone while youmove around your classroom. For example, you can do the following:

l Mute or adjust the volume of your voice on themicrophone.

l Mute or adjust the volume of an auxiliary audio input device connected to your microphone.

l Mute or adjust volume of auxiliary audio inputs connected to the control unit or the ECP of your
interactive whiteboard.

Controlling your SMARTAudio system from SMARTNotebook software
Your SMART Audio system is integrated with SMART Notebook software so that you can
conveniently control the SMART Audio system from your interactive whiteboard.

Press theSMART Audio icon on the SMART Notebook software toolbar, and then you can do
the following:

l Mute or adjust the volume of up to twomicrophones

l Mute or adjust the volume of audio files playing on your computer

l Mute or adjust the volume of audio files playing on connected auxiliary input devices

l Set the tone for your ceiling speakers or wall speakers

CHA PT ER 1
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Overview of the SMART Audio system
This is a basic cabling diagram showing the relationship between all of the components in the
SMART Audio system. For more information on installing and cabling your SMART Audio system,
see theSMART Audio CAS-340 and CAS-360 installation guide (smarttech.com/kb/155320).

Room module
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Physical components
Your SMART Audio system includes the following items:

l Control unit and power supply
l Microphone, sleeve and lanyard
l Microphone charging cradle and its power supply
l Ceiling-installed roommodule, infrared sensor and audio amplifier
l Either four ceiling speakers or four wall speakers

Control unit
The control unit is a wall-mounted panel that connects the SMART Audio system to your computer.
For more information on using the control unit, see page 9.

CAS-340 top view
The top of the CAS-340 has a power button.

CAS-360 top view
The top of the CAS-360 includes a power
button, an LCD control screen and adjustment
dial. You can customize some of the audio
functions from the screen.

CAS-340 and CAS-360 bottom view
The underside of the control unit has a removable
panel. Under the panel are the following:

l USB connection to the computer

l RCA connections for auxiliary inputs such
as DVD/Blu-ray players and VCRs

l Connectors for assistive listening devices

l RJ45 connection for the Cat 5e cable to the
roommodule

l System power input

l System reset button

Aux In Out
To R M 19 VD C

RESE T
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The roommodule contains the infrared sensor
and the speaker amplifiers. The roommodule is
ceiling-mounted and is connected to all of the
speakers.

The roommodule connects to the control unit with a Cat 5e cable.

Ceiling speakers
SMART Audio system ceiling speakers receive both power and sound input
through speaker wire from the roommodule. Speaker strength is 30W.

Wall speakers
SMART Audio system ceiling speakers receive both power and
sound input through speaker wire from the roommodule.
Speaker strength is 30W.

Microphone
Your SMART Audio system includes amicrophone that transmits an infrared signal by line
of sight up to 15' (4.6 m) to a receiver in the roommodule. Themicrophone has a built in
voice receiver and you can also add external wiredmicrophones to the 3.5mm jack on the
side of themicrophone.

You can attach the included lanyard to themicrophone and wear it around your neck. The
microphone has power, volume andmute buttons.

Microphone charging cradle
Charge themicrophone in the wall-mountedmicrophone charging
cradle provided with your SMART Audio system.
For more information on charging your microphone, see page 13.

W  WARN ING

l Do not charge the battery with any charger other than the one
supplied. Do not charge other battery types in your SMART
product with the supplied power adapter. These actions can
cause damage to the product and can cause a fire or personal
injury.

l If the SMART product becomes excessively warm or emits
an unusual smell while the battery is recharging, immediately
disconnect the power cable from the power outlet.

CHA PT ER 1
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SMART software
Your SMART Audio system operates without additional software. However, the following software
will extend your usage of the SMART Audio system.

l SMART Notebook software and SMART Product Drivers enable you to access commonly
used audio settings, such as volume control, while teaching.

l SMART Audio software enables you to control the SMART Audio system from SMART
Notebook software.

l SMART Audio configuration software enables an installer or system administrator to
customize the SMART Audio system.

You can install SMART software from the included CD or from smarttech.com/downloads.

CHA PT ER 1
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Chapter 2: Using the control unit
Turning on and turning off your SMART Audio system 9
Auxiliary audio inputs for the control unit 10

Connecting auxiliary audio input devices to the control unit 10
System reset 10

The control unit has the following roles in your SMART Audio system:

l Providing power to the roommodule and the speakers through the Cat 5e cable to the room
module

l Connecting to your computer for audio system adjustments using the SMART Audio system
software

l Providing customization through an LCD screen and adjustment dial (CAS-360 only)

l Providing volume control (CAS-360 only)

Turning on and turning off your SMART Audio
system
Your control unit has a power button that turns on your SMART Audio system, including your room
module and ceiling speakers or wall speakers, and turns off your SMART Audio system.

Power button

g To turn on or turn off your SMART Audio system

Press the power button on the control unit.

Chapter 2
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I   I MPORTANT

Themicrophone has its own power button. For more information, see page 15.

Auxiliary audio inputs for the control unit
You can connect auxiliary audio inputs to the control unit, such as a CD player, VCR, DVD/Blu-ray
player or other media device. You can transmit sound from these devices as an alternative to voice
input from your microphone.

When your SMART Audio system is turned on, you can control the volume andmute features using
the auxiliary input controls, with SMART Audio software (see page 27), or the systemmicrophone
(see page 17).

N   NOTE

Formore information on connecting audio inputs directly to themicrophone, see page 16.

Connecting auxiliary audio input devices to the control unit

g To connect the auxiliary audio input device to the control unit

1. Ensure that the auxiliary audio input device is turned off.

2. Remove the bottom cover from the control unit.

3. Connect two RCA input plugs to the Aux 2 inputs.

4. Replace the cover on the control unit.

System reset
If you encounter issues with your SMART Audio system, you can reset it.

g To reset the system

1. Remove the control unit bottom cover.

2. Press the labeled system reset button for three seconds.

The system resets.

3. Replace the control unit bottom cover.

CHA PT ER 2
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Chapter 3: Using the SMART Audio system
microphone
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Assembling themicrophone 12

Placing a battery in themicrophone 13
Using themicrophone's protective sleeve 13
Connecting the lanyard to themicrophone 13

Charging themicrophone 13
Charging time 14
Charge duration 14

Turning on and turning off themicrophone 15
Connecting themicrophone to the roommodule 15
Speaking into themicrophone 15

Adjustingmicrophone volume 16
Adding auxiliary microphones 16

Connecting auxiliary audio input devices to themicrophone 16
Controlling an auxiliary audio input device using themicrophone 17
Using a secondmicrophone 18

Usingmicrophone channels 18
Checking your microphonemode 18
Enabling Assigned Channel mode 19
Enabling Find Channel mode 19

Customizing amicrophone 20
Enabling Button Disablemode 20
Enabling Automatic On and Automatic Off mode 21
Downloading global settings from the control unit 22

The SMART Audio systemmicrophone is a voice input device that transmits a line-of-sight infrared
signal up to 15' (4.6 m) to the roommodule. The roommodule receives the input, and then passes the
audio input to the speakers through the speaker wires according to SMART Audio software settings.

Chapter 3
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You can use a secondmicrophone with the SMART Audio system. For more information, see page
18.

Themicrophone is battery operated and chargeable with the includedmicrophone charging cradle. For
more information, see page 13.

Parts of the microphone
Themicrophone has several controls and connections, as described below.

Assembling the microphone
Themicrophone has a battery, a protective sleeve and a lanyard.

CHA PT ER 3
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Placing a battery in themicrophone
Themicrophone uses a replaceable, rechargeable 3.7V lithium ion battery.

g To place a battery in the microphone

1. Remove the back panel of themicrophone.

2. Remove the plastic film from the battery.

3. Insert the battery into themicrophone with the label facing out and down.

4. Replace the back panel of themicrophone.

Using themicrophone's protective sleeve
Themicrophone has a protective sleeve. Slide themicrophone into the sleeve to reduce sound
transfer from tapping themicrophone and to protect themicrophone from damage.

Connecting the lanyard to themicrophone
Themicrophone has a lanyard for hands-free use.

g To connect the lanyard to the microphone

Slide the lanyardmounting plate into the back of themicrophone.

Charging the microphone
You can charge themicrophone in themicrophone charging cradle or by connecting the charging
cable directly to the bottom of themicrophone.

CHA PT ER 3
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W  WARN ING

l Do not charge the battery with any power adapter other than the one supplied.

l Do not charge other battery types in your SMART product with the supplied power adapter.
Both of these actions can cause damage to the product and can cause a fire or personal
injury.

l If the SMART product becomes excessively warm or emits an unusual smell while the
battery is charging, immediately disconnect the power adapter from the power outlet and turn
off the product.

Charging time
It takes approximately one hour to charge themicrophone.

Charge duration
A full charge provides approximately seven hours’ use. This time can vary depending on the
frequency of transmission, battery age and room temperature.

g To charge the microphone in the microphone charging cradle

1. Connect AC power adaptor into themicrophone charging cradle.

2. Place themicrophone in the charger facing out.

T   T I P

Themicrophone is more stable if it is in its protective sleeve.
For more information, see page 13.

The red light will start to flash when themicrophone is charging,
and will turn solid red when themicrophone is fully charged.

g To charge the microphone directly

Connect the AC power adapter jack directly to the connection on bottom of microphone.

CHA PT ER 3
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Turning on and turning off the microphone
T   T I P

You can set your microphone to turn off automatically when placed in themicrophone charging
cradle, and to turn on when removed from themicrophone charging cradle. For more information,
see page 20.

g To turn on the microphone

Press any button on themicrophone.

Themicrophone status light flashes red, and then turns solid green.

I   I MPORTANT

If you do not see a light or you see an amber light, see Troubleshooting using themicrophone status
light.

g To turn off the microphone

Press themute button for four seconds.

Themicrophone status light turns off.

Connecting the microphone to the roommodule
When your microphone is connected to the roommodule, the status light will be solid green. If it’s
amber or flashing red, it isn’t connected.

g To connect the microphone to the room module

1. Stand within 15' (4.6 m) of the roommodule.

2. Point themicrophone's infrared transmitter at the roommodule.

3. Turn off themicrophone, and then turn it on again.

Speaking into the microphone
Yourmicrophone contains a voice receiver and transmits your voice input to the roommodule.

CHA PT ER 3
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Yourmicrophone uses a line of sight infrared signal to communicate with the roommodule. The
maximum distance for this is 15' (4.6 m).

I   I MPORTANT

l Hold your microphone so the infrared transmitter faces out.

l If you hear a sudden squelch, Themicrophone is either out of range or pointed against a non-
reflective surface. Position your microphone so the infrared transmitter points toward the
roommodule.

Adjustingmicrophone volume
You can increase or decrease the volume of transmission from themicrophone, as well as mute and
restore volume.

g To increase or decrease the microphone volume

Press the volume up or volume down button.

g To mute or restore the microphone volume

Press themute button.

When youmute themicrophone, themicrophone status light flashes green. When you restore the
microphone volume, themicrophone status light turns solid green.

Adding auxiliary microphones
Themicrophone has a voice receiver and doesn't require an external,
auxiliary microphone. If you prefer to use an auxiliary microphone,
contact your authorized SMART reseller.

g To add an auxiliary microphone

Connect the auxiliary microphone to the 3.5mm jack.

Connecting auxiliary audio input
devices to the microphone
Themicrophone has a 3.5mm input jack enabling you to connect an external audio source such as a
handheld audio player or other sound player. The input is mixed with voice input, enabling you to
speak over the auxiliary audio input device.

CHA PT ER 3
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g To connect auxiliary audio input devices

1. Turn on the auxiliary audio input device, and then reduce the
volume on the device.

2. Connect the auxiliary audio input device output jack to the
microphone auxiliary input 3.5mm jack.

3. Increase the volume control on the auxiliary audio input device
until the auxiliary audio input device is clearly and comfortably
heard over the SMART Audio system.

3.5 mm jack for
auxiliary input 

devices

g To mute or restore volume for an auxiliary audio input device

Press themute button on themicrophone.

Controlling an auxiliary audio input device using
the microphone
You can use themicrophone to increase the volume, lower the volume ormute themost recently
active auxiliary audio input device connected to the control unit without returning to your computer or
the auxiliary input device.

This enables you to decrease or mute the volume, provide commentary and return to transmitting
audio.

g To adjust the volume of the device connected to the control unit using the microphone

1. Press themute button on your microphone so that your voice doesn’t transmit.

Themicrophone status light flashes green.

2. Use the volume control buttons to adjust the volume of the device connected to the control unit.

N   NOTE

This volume control is very precise. Youmust press a volume button several times before
you notice a difference.

g To mute or restore volume to a device connected to the control unit using the microphone

Press the soft button on your microphone.
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Using a second microphone
You can purchase a secondmicrophone as a back-up or to use as a secondmicrophone while
teaching.

A secondmicrophone is typically used as a student microphone that can be passed around a group of
students while the teacher is using the primary microphone.

T   T I P

You can set the student microphone to Button Disablemode so students can’t adjust the volume on
their microphone or on any auxiliary audio input devices. For more information, see page 20.

Usingmicrophone channels
The SMART Audio system microphone can transmit on two channels: channel 1 and channel 2. Set
your microphonemode to determine the channel.

l In Find Channel mode (default), themicrophone chooses an available channel.

l In Assigned Channel mode, themicrophone transmits on the channel you assign it.

I   I MPORTANT

Twomicrophones can not be set to the same channel at the same time.

Checking your microphonemode
You can check to see whether amicrophone is set to Find Channel mode or Assigned Channel mode.

g To check the microphone mode

1. If themicrophone is turned on, turn it off by holding themute button for four seconds.

2. Turn on themicrophone by pressing any button.

CHA PT ER 3
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3. Observe themicrophone status light.

If themicrophone status light flashes red once, themicrophone is set to Assigned Channel
mode and channel 1.

OR

If themicrophone status light flashes red twice, themicrophone is set to Assigned Channel
mode and channel 2.

OR

If you don’t see a red flashing light, themicrophone is set to Find Channel mode.

Enabling Assigned Channel mode
In Assigned Channel mode you can set amicrophone to transmit on either channel 1 or channel 2.

I   I MPORTANT

Twomicrophones can not be set to the same channel at the same time.

g To set a microphone to Assigned Channel mode

1. Turn off themicrophone by holding themute button for four seconds, and then wait 10 seconds.

2. Hold the soft button and themute button for three seconds, and then release the buttons.

Themicrophone status light flashes red rapidly.

3. Press the soft button to set themicrophone to channel 1.

OR

Press the volume up button to set themicrophone to channel 2.

Themicrophone status light turns solid green.

Enabling Find Channel mode
In Find Channel mode, themicrophone looks for an available channel.

I   I MPORTANT

Twomicrophones can not be set to the same channel at the same time.
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g To set a microphone to Find Channel mode

1. Turn off themicrophone by holding themute button for four seconds, and then wait 10 seconds.

2. Hold the soft button and themute button for three seconds, and then release the buttons.

Themicrophone status light flashes red rapidly.

3. Wait 18 seconds. Don’t push any buttons.

Themicrophone status light turns solid green.

Customizing a microphone
You can customize amicrophone to change some of its settings, including the followingmodes:

l In Button Disablemode, only themute button works. For more information, see below.

l In Automatic On and Automatic Off mode, themicrophone turns off when you place it in a
charger and turns on when you remove it. For more information, see page 21.

N   NOTE

Your system administrator could have set either of these settings as global settings to be
downloaded from the roommodule. Following the steps below overrides the global setting until the
next time someone downloads the global settings. For more information, see page 22.

Enabling Button Disablemode
In Button Disablemode, only themute button works, so students can’t adjust the volumewhile you
pass themicrophone around.

g To set a microphone to Button Disable mode

1. Turn on themicrophone.

2. Press and hold the soft button and volume down button for five seconds.

Themicrophone status light flashes red, yellow and green alternately indicating that you’re in
Local Programmingmode.
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3. Press themute button and hold it for one second to change the state of the Button Disable
mode.

I   I MPORTANT

o Four quick green flashes of themicrophone status light indicates that the feature is on
and only themute button works.

o Four quick red flashes of themicrophone status light indicates that the feature is off
and all buttons work.

4. Press the soft button and volume down button for three seconds to exit Local Programming
mode.

OR

Wait 30 seconds and themicrophone will automatically exit Local Programmingmode.

Enabling Automatic On and Automatic Off mode
You can set themicrophone to Automatic On and Automatic Off mode, which turns themicrophone
off when you place it in themicrophone charging cradle and turns it on when you remove it from the
microphone charging cradle.

g To set a microphone to Automatic On and Automatic Off mode

1. Turn on themicrophone.

2. Press and hold the soft button and volume down button for five seconds.

Themicrophone status light flashes red, yellow and green alternately indicating that you’re now
in Local Programmingmode.

3. Press the volume down button to change the state for themicrophone Automatic On and
Automatic Off mode.

I   I MPORTANT

o Four quick green flashes of themicrophone status light indicates that the feature is on
and themicrophone will turn off when in the charger and turn on when removed.

o Four quick red flashes of the light indicates that the feature is off and themicrophone
must be turned on or off manually.
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4. Press the soft button and volume down button for three seconds to exit Local Programming
mode.

OR

Wait 30 seconds and themicrophone will automatically exit Local Programmingmode.

Downloading global settings from the control unit
You system administrator could have designated certain default settings for your microphone.
Downloading these global settings from the control unit ensures your microphone operates as
expected.

I   I MPORTANT

Yourmicrophonemust be in Find Channel mode to download global settings. For more information
on Find Channel mode, see page 19.

These global settings could include the following:

l Volume limits for microphones (see page 39)

l Low battery status light indication (see page 44)

l Automatic shut off when charging (see page 44)

l Button Disablemode (see page 45)

l Custom functions for the soft button (see page 46)

N   NOTE

You can override two of these global settings by programming your microphone directly. These
include Button Disablemode and Automatic On and Automatic Off mode (see page 20). These
override settings are overwritten the next time you download global settings from the control unit.

g To download global settings from the control unit

1. Turn on your SMART Audio system at the control unit.

2. Turn on your microphone, and wait until its status light is solid green.

I   I MPORTANT

If themicrophone status light is amber, themicrophone is not connected to the roommodule
and you are unable to download global settings.

3. Press the volume up and volume down buttons for five seconds.
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Themicrophone status light flashes amber.

4. When themicrophone status light is solid green, you can use themicrophone.
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Your SMART Audio system is integrated with SMART Notebook software so that you can
conveniently control the system when using your interactive whiteboard.

By pressing theSMART Audio icon on your SMART Notebook software toolbar, you can do the
following:

l Mute or adjust the volume of up to twomicrophones

l Mute or adjust the volume of audio files playing on your computer

l Mute or adjust the volume of audio files playing on connected auxiliary input devices

l Set the tone for your ceiling speakers or wall speakers

Installing SMART Audio software
If theSMART Audio icon isn’t on the SMART Notebook software toolbar, install SMART Audio
software from the included CD or from the SMART website.
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g To install SMART Audio software for Windows

1. Disconnect the USB cable that connects your computer to your control unit.

2. Insert the included SMART Audio software CD in your computer, and then browse to the
SMARTAudioSetup.exe file.

OR

Go to smarttech.com/downloads, select the SMART Audio software downloads, and then
downloadSMARTAudioSetup.exe to your desktop.

3. Double-click SMARTAudioSetup.exe, and then follow the on-screen instructions to install
SMART Audio software.

g To install SMART Audio software for Mac

1. Disconnect the USB cable that connects your computer to your control unit.

2. Insert the included SMART Audio software CD in your computer, and then browse toSMART
Audio Install.dmg file.

OR

Go to smarttech.com/downloads, select the SMART Audio software downloads, and then
downloadSMART Audio Install.dmg to your desktop.

3. Double-click SMART Audio Install.dmg, and then follow the on-screen instructions to install
SMART Audio software.

Placing the SMART Audio system toolbar icon
If you don't see the SMART Audio icon on your SMART Notebook software toolbar, you can add it
from theCustomize Toolbarwindow.

g To place your SMART Audio system icon on your SMART Notebook software toolbar

1. Open SMART Notebook software.

2. Select View > Customize Toolbar.

TheCustomize Toolbarwindow appears.

3. Drag theSMART Audio icon to your SMART Notebook software toolbar.

4. Press Done.
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Opening SMART Audio software
SMART Audio software enables you to control the SMART Audio system from your interactive
whiteboard.

g To open SMART Audio software from SMART Notebook software

1. Open SMART Notebook software.

2. Press theSMART Audio icon .

SMART Audio software appears.

3. Press Connect.

Using SMART Audio system teacher settings
Your SMART Audio system teacher settings enable you to do the following:

l Connect your control unit to the roommodule.

l Increase or decrease the volume of the twomicrophone channels or any auxiliary audio inputs.
For more information, see page 27.

l Mute the twomicrophone channels or any auxiliary audio inputs. For more information, see
page 28.

l Check themicrophone battery level by channel. For more information, see page 28.

l Set speaker tone. For more information, see page 29.

Changing SMARTAudio system input volumes
Your SMART Audio systemmixes audio inputs from the following sources:

l Mic 1, the default SMART Audio systemmicrophone channel

l Mic 2, another SMART Audio systemmicrophone channel

l USB Audio, audio or video files playing on the computer and transmitted to the control unit
through the USB connection
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l Aux 1, the connection from your SMART Board projector to your control unit, and streams any
audio inputs connected directly to your SMART Board interactive whiteboard or ECP

T   T I P

You can rename Aux 1 or Aux 2 to a termmore descriptive of the audio input. For more
information, see page 47.

l Aux 2, any auxiliary audio input device connected to the control unit. For more information, see
page 10

You can adjust the volumes of these inputs to your preference.

Adjusting volume for SMART Audio system auxiliary audio input devices
All audio inputs into the SMART Audio system speakers aremixed. You can adjust the volume of any
audio inputs.

T   T I P

You can also adjust volume for inputs at the input source. To adjust the input from the SMART
Audio system microphone, see page 16.

g To adjust the volume for a SMART Audio system input

Slide the input’s volume slider up or down for the input.

Muting SMARTAudio system inputs
All audio inputs into the SMART Audio system speakers aremixed. You canmute any or all inputs,
and restore their volume later.

g To mute a SMART Audio system input

Press the un-muted speaker icon below the input volume slider.

g To restore a SMART Audio system input’s volume

Press themuted speaker icon below the input volume slider.

Checkingmicrophone battery level
You can use SMART Audio software to check your microphone battery level.
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N   NOTE

If your microphone battery level is below 10%, themicrophone status light flashes red. For more
information, see Troubleshooting the infrared transmittingmicrophone status light.

g To check microphone battery level

1. Press theSMART Audio icon on the SMART Notebook software toolbar.

SMART Audio software appears.

2. Look at theMicrophone battery level area.

I   I MPORTANT

If this area indicates Nomic found, your microphone is either not turned on (see page 15) or
not connected to the roommodule.

Setting speaker tone
SMART Audio system enables you to set speaker tone.

To set speaker tone
1. Select the SMART Audio icon on the SMART Notebook software toolbar.

SMART Audio software appears.

2. Press High,Medium or Low.
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Troubleshooting using the microphone status
light
The normal state for themicrophone status light is solid green. Use the following table if the light isn’t
on or if it isn’t solid green.

Status light Cause Solution

Themicrophone status
light is off

Your microphone is turned
off.

Press any button on your microphone.

Your microphone battery
isn’t charged.

Charge your microphone battery in the
microphone charging cradle.

Flashing red twice per
second

Battery power is at 10% of
its full charge.

Charge the battery.

Flashing red four times
per second

Battery power is at 5% of its
full charge.

Charge the battery.

Solid amber Your roommodule isn’t
receiving power

Press the power button on the control unit.

You’re out of range of your
roommodule.

Move within 15' (4.6 m) of the roommodule.

Flashing green Themicrophone is muted. Press themute button to restore the
microphone’s volume.

Solid green Normal operation No action required
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Troubleshooting no voice transmission from the
microphone issues
Use this table if your voice doesn’t come through the speakers when you speak into themicrophone.

I   I MPORTANT

Use this table only if the status light on your microphone is solid green. If it is not on, or if it is a color
other than solid green, see Troubleshooting the infrared transmittingmicrophone status light.

Cause Solution

Your volume is too low on the
microphone.

Increase the volume.

Your microphone volume is too low
in SMART Audio software.

Open SMART Audio software, and increase the volume.

Your microphone isn’t connected to
the roommodule

Turn your microphone toward the roommodule, and then
move to within 15' (4.6 m) of the roommodule.

The SMART Audio system is turned
off.

Turn on the SMART Audio system.

Troubleshooting issues with auxiliary audio input
devices
Use the following table if you can’t hear an auxiliary audio input device playing on your SMART Audio
system.

Cause Solution

The file isn’t playing. Play the file.

Your computer is muted. Restore the volume for your computer.

The input device is muted at your
control unit.

Open SMART Audio software and restore the volume.

The SMART Audio system is turned
off.

Turn on the SMART Audio system.

There is no USB connection from your
computer to your control unit.

Connect a USB cable from your computer to your control
unit.
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Setting audio input names and trims 47
Input names 48
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System settings 48
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Relay settings 49

Your SMART Audio system is designed to operate once installed without any special settings. You
can, however, customize your SMART Audio system tomeet requirements or to improve your audio
experience.

System administrators can customize settings using the SMART Audio system configuration
software.

I   I MPORTANT

Do not install SMART Audio configuration software on teacher computers unless you want to give
them access to the configuration settings. The SMART Audio software available through
SMART Notebook software provides the controls that a teacher requires. For more information, see
page 25.

Installing SMART Audio configuration software
If you don’t have SMART Audio configuration software installed on your computer, install it from the
included CD or from the SMART website.

I   I MPORTANT

You require a computer with aWindows operating system to install and run SMART Audio
configuration software. After your SMART Audio system is configured, you can run SMART Audio
software from SMART Notebook software on a computer with either aWindows operating system
orMac operating system software.
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g To install SMART Audio configuration software

1. Disconnect the USB cable that connects your computer to your control unit.

2. Insert the included SMART Audio software CD in your computer, and then browse to the
SMARTAudioConfigSetup.exe file.

OR

Go to smarttech.com/downloads, select the SMART Audio software downloads, and then
downloadSMARTAudioConfigSetup.exe to your desktop.

3. Double-click SMARTAudioConfigSetup.exe, and then follow the on-screen instructions to
install SMART Audio configuration software.

Using SMART Audio configuration files
SMART Audio configuration files includemany settings that affect the operation of your SMART
Audio system. These files are stored in the control unit, but you can also store them on a computer or
USB drive as a backup.

The file extension for SMART Audio configuration files is LPT.

You can edit an LPT file using SMART Audio configuration software. Access a file in one of the
following ways:

l Open SMART Audio configuration software to see the default settings in a file. For more
information, see page 36.

l Open SMART Audio configuration software on a computer connected to a control unit, and then
download the control unit's LPT file to the computer. For more information, see page 37.

l Open a LPT file on a computer or USB drive. For more information, see page 36.

You can then edit audio settings in the LPT file.

l To edit system volume, see page 38.

l To edit speaker controls, see page 39.

l To edit paging control and 6-12 VDC input settings, see page 42.

l To edit microphone settings, see page 44.

l To edit audio input names and trims, see page 48.

l To edit other system settings, see page 48.
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After you edit the LPT file, you can do one of the following:

l Upload the settings to a connected control unit. For more information, see page 37.

l Save the settings as an LPT file to upload to a control unit at another time. For more
information, see page 37.

Opening SMARTAudio configuration software
SMART Audio configuration software is designed to help system administrators configure SMART
Audio system settings.

I   I MPORTANT

This software is not designed for end users. Teachers and other presenters should use SMART
Audio system software accessed from SMART Notebook software.

g To open SMART Audio configuration software

1. Select Start > All Programs > SMART Technologies > SMART Tools.

2. Click Audio Configuration Software.

TheSMART Audio Configuration Software screen appears.

I   I MPORTANT

If a warning appears stating that Windows does not see the SMART device, connect your
computer to a SMART Audio system control unit with a USB cable.

Opening a SMARTAudio configuration file
You can open a SMART Audio configuration file with SMART Audio configuration software, and then
upload it to a connected control unit. This could be part of implementing settings or restoring a backup
of settings.

g To open a SMART Audio configuration file

1. Open SMART Audio configuration software (see page 36).

2. Select File > Open.

3. Browse to and select the LPT file.

SMART Audio configuration software settings are loaded from the file.
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Downloading a configuration file from the control unit
You can download the current configuration file from the control unit, typically to do one of the
following:

l Configure specific settings.

l Store a backup of the control unit's settings.

l Copy the specific settings, and then upload them to another control unit in another room.

g To download a configuration file from the control unit

1. Open SMART Audio configuration software (see page 36).

2. Select theSetup tab.

3. Click Download Configuration File from CU.

The file downloads from the control unit to your computer.

4. Edit the file, and then upload it to your control unit (For more information, see page 37).

OR

Select File > Save to save the configuration file to your desktop.

Uploading a configuration file to the control unit
After you edit the settings, upload them to the control unit.

g To upload configurations to the control unit

1.1. Open SMART Audio configuration software (see page 36).

2. Select theSetup tab.

3. Click theUpload Configuration File to the CU button.

SMART Audio configuration software settings are uploaded to the control unit.

Saving configuration files to a computer
After you edit settings, you can save the LPT file to your computer as a backup or to upload to another
SMART Audio system control unit.
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g To save configuration files

1. Select the File > Save or File > Save as.

2. Type a file name, and then click OK.

SMART Audio configuration software settings are saved to the file.

Setting base volumes with the volume tab
The SMART Audio configuration software Volume tab enables you to do the following:

l Set amaster default volume for all audio input devices.

l Set specific default volumes for specific audio input devices.

Auxiliary input volume can be set in a range from -40 dB to 8 dB. Microphone volumes can be set in a
range from -40 dB to +6 dB.

These form a base from which other volume controls can be applied.

Settingmaster volume
The SMART Audio system master volume control sets a base volume that can further be adapted by
other settings in the SMART Audio system.

g To set master volume

1. Select theVolume tab.

2. Move theMaster Volume slider up or down.

OR

Use the up or down arrows to change the volume.

Setting other inputs’ volume
You can set the base volumes for several auxiliary audio input devices.
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g To set input volume

1. Select theVolume tab.

2. Move theAux 1, Aux 2 or USB Audio slider up or down.

OR

Use the up or down arrows to change the volume.

N   NOTE

You can give these inputs amore descriptive name, such as "CD player," using SMART
Audio configuration software. For more information, see page 47.

Settingmicrophone volume
You can set the base volume for twomicrophone channels.

N   NOTE

Mic 1 controls the volume for channel 1 andMic 2 controls the volume for channel 2.

g To set the input volume

1. Select theVolume tab.

2. Move theMic 1 orMic 2 slider up or down.

OR

Use the up or down arrows to change the volume.

I   I MPORTANT

Youmust have amicrophone turned on, set to the channel and connected to the room
module to set input volume. For more information, see page 18.

Using the speaker control tab
The SMART Audio configuration software Speaker Control tab enables you to do the following:

l Select speaker and room equalization settings for the speakers connected to the roommodule
and the audio characteristics of the room.

l Trim the amplifiers (speakers).

l Save room-specific equalizations.
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T   T I P

All settings in this tab can be saved as an equalization group in the LPT file. This enables you to
save different rooms' equalization settings in one LPT file. For more information, see page 41.

Setting speaker and room equalization
Your SMART Audio system has two independent equalization circuits: speaker equalization and
room equalization.

Speaker equalization
Speaker equalization is a defined set of equalization curves for industry standard speakers.

T   T I P

TheSMART Audio Room Speaker library is part of the firmware and can be updated.

g To set speaker equalization

1. Select theSpeaker Control tab.

2. In theSpeaker EQ drop-down list, select your speaker.

OR

Select Flat if your speaker type isn’t listed.

Room equalization
The room equalization circuit is helpful when you have room-specific anomalies, such as bass
buildup, ringing or areas of feedback. The room equalization circuit consists of seven bands of
parametric equalization.

I   I MPORTANT

To select the filter type or other parametric settings, use theRoom Equalization Parameters menu.

g To set room equalization

1. Select theSpeaker Control tab.

2. In theRoom Equalization area, raise or lower the slider for each band.

OR

On the Level box, use the up and down arrows to raise or lower the level.
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Room equalization parameters
For bands 3 to 6 you can select the type of filter (Peak/dip, Notch, Shelving, and Band pass), the
center frequency and the bandwidth of the equalization curve.

g To set room equalization parameters

1. Select theSpeaker Control tab.

2. For each band, set the Filter Type, Frequency andBandwidth.

N   NOTE

You can set frequency only for band 1 (bass) and band 7 treble).

Setting amplifier trim
If a speaker is too loud or quiet for a portion of the room, adjust the speaker trim down -12 dB or up
+6dB in 1dB increments.

N   NOTE

Adjusting the trim too high can cause feedback.

g To set amplifier trim

1. Select theSpeaker Control tab.

2. Use the up and down arrows in theAmplifier Trims area to adjust the trim from -12 dB to 6 dB.

N   NOTE

The default setting is 0 dB.

Saving and recalling equalizations
You can save equalizations in the roommodule to enable you to respond to different situations in the
same SMART Audio installation or to save several rooms’ equalization settings in the same LPT file,
and then later apply them to each individual room.

g To save equalization settings

1. Create your equalization settings.

2. In theSave EQ drop-down list, select the name you prefer for the current equalization.

3. Click theSave Selected EQ button.
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g To recall equalization settings

1. Select theSpeaker Control tab.

2. Select an Equalization from theRecall EQ drop-down list.

Setting responses to incoming pages
The SMART Audio configuration softwarePaging tab enables you to do the following:

l Set paging input trim if you will connect the paging system to your roommodule.

l Set a duck on page.

l Set a duck on a 6-12 VDC input.

SMARTAudio and paging
When you install your SMART Audio system roommodule, you can connect it to your existing paging
system with either the paging input or the 6-12 VDC connection.

PAGIN G
INPU T

6-12VDC
INPU T

NI NI

TO C U
RELAY

OUTPU T

N.C. N.O.COM

SMART Bus

Expansion
  Sensors

6-12 VDC connectionPaging input

Use the SMART Audio system configuration software to define how the SMART Audio system
responds to an incoming page.

W  WARN ING

Paging systems often deliver important safety information. Use a professional installer to connect
the roommodule to an existing paging system so that pages are heard reliably.

Setting incoming page volume
If you connect your existing paging system to your SMART Audio system roommodule, you can trim
the input when a page occurs. The following are common page volume scenarios:

l Trimming the incoming page to -19 dB so that pages don’t play over SMART Audio system
speakers, because the paging input already runs to other speakers in the room. Page ducking
of other SMART Audio system inputs is still possible. For more information, see page 43.
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l Trimming to increase the volume or decrease the volume of the paging input that plays over the
SMART Audio speakers.

g To increase or decrease the volume of the incoming page

1. Select thePaging tab.

2. Use thePaging Input Trim arrow buttons to adjust the page input trim from -19 dB to 6 dB.

Setting SMARTAudio system volume during a page
For an external page to duck the SMART Audio system, the roommodule requires either of the
following:

l A signal at the paging input (even if the page plays on speakers that aren’t part of the
SMART Audio system)

l A signal at the 6–12V input. This is only a signal and doesn’t result in the page playing over the
SMART Audio system.

Duck on page
When a signal is present at the paging input, the other SMART Audio system inputs are ducked the
designated amount.

g To set Duck on Page

1. Select thePaging tab.

2. Select a ducking level in the Duck on Page drop-down list.

Ducking level Volume change during a paging input

none No change

low -6 dB

medium -12 dB

high -18 dB

Setting ducking on 6-12 VDC input
When a signal is present at the 6-12 VDC input, the other SMART Audio system inputs are ducked
the designated amount.

g To set Duck on 6-12 VDC Input

1. Select thePaging tab.

2. Select a ducking level in theDuck on 6-12v drop-down list. 
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Ducking level Volume change during a 6-12 VDC input

none No change

low -6 dB

medium -12 dB

high -18 dB

Setting microphone features
The SMART Audio configuration softwareMicrophones tab enables you to do the following:

l Set a low battery microphone status light indicator.

l Enable or disable automatic shut off when charging.

l Set Button Disablemode.

l Enable or disable auxiliary input volume control from themicrophone.

l Set the action of the soft button when pressed quickly.

l Set the action of the soft button when pressed and held.

I   I MPORTANT

After you upload themicrophone settings to a control unit, youmust download them from the
control unit to eachmicrophone by holding the volume up and volume down buttons for four
seconds. For more information, see page 22.

Setting the low battery indication
You can program themicrophone status light to flash when the battery is low.

l At 10% battery charge the light will flash red twice per second.

l At 5% battery charge the light will flash red four times per second.

g To set the low battery indication

1. Select theMicrophone tab.

2. Select the Low Battery LED checkbox.

Setting Automatic On and Automatic Off mode
This setting turns off microphones when they’re placed in themicrophone charging cradle and turns
them onwhen they’re removed.
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N   NOTE

This is a global setting for all microphones in the system. You can also program a specific
microphone for a specific response. For more information, see page 21.

g To set Automatic On and Automatic Off mode

1. Select theMicrophone tab.

2. Select theAuto off when charging checkbox.

Setting Button Disablemode
Button Disablemode disables the buttons of themicrophone, preventing users from changing volume
settings. TheMute button isn’t disabled with this feature.

N   NOTE

This is a global setting for all microphones in the system. You can also program a specific
microphone for a specific response. For more information, see page 20.

g To set Button Disable mode

1. Select theMicrophone tab.

2. Select the Disable buttons on microphone checkbox.

Setting auxiliary volume control from themicrophone
You can use themicrophone to increase the volume, decrease the volume ormute themost recently
active auxiliary audio input device at the control unit without returning to your computer or the input
device. For more information, see page 17.

Press themute button on themicrophone to take control of the volume for the auxiliary audio input
device.

N   NOTE

Auxiliary audio input refers to external input sources at the control unit, not at themicrophone.
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g To set auxiliary volume control

1. Select theMicrophone tab.

2. In theAux Volume Control drop-down list, select on mute to enable the user to control
auxiliary audio input device volumewhen themicrophone is muted.

OR

Select disable to prevent the user from controlling auxiliary audio input device volume using
themicrophone.

Setting auxiliary ducking
The auxiliary ducking settings enables you to reduce the volume of the auxiliary input devices at the
control unit when speaking into themicrophone.

This is helpful if you want to talk over a DVD/Blu-ray or other auxiliary audio input device at the
control unit.

g To set auxiliary ducking

1. Select theMicrophone tab.

2. Select a ducking level in theAux Ducking drop-down list.

Ducking level Volume change during microphone transmission

none No change

low -6 dB

medium -12 dB

high -18 dB

Setting soft button short response
You can designate a response for when a user presses the soft button on amicrophone for less than
four seconds. Typically this will be tomute auxiliary inputs at the control unit, but it can trigger a relay
or have no action.
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g To set soft button short response

1. Select theMicrophone tab.

2. Select Aux Mute in theSoft Button - Short drop-down list to mute auxiliary inputs at the
control unit.

OR

Select Relay to trigger a relay at the relay input.

OR

Select No Action for no response to quickly pressing the soft button.

Setting soft button long response
You can designate a response for when a user presses the soft button on amicrophone for more than
four seconds. Typically this mutes auxiliary audio input devices at the control unit, but it can also
trigger a relay or have no action.

g To set soft button long response

1. Select theMicrophone tab.

2. Select Aux Mute in theSoft Button - Long drop-down list to mute auxiliary inputs at the
control unit.

OR

Select Relay to trigger a relay at the relay input.

OR

Select No Action for no response to pressing the soft button for longer than four seconds.

Setting audio input names and trims
Your SMART Audio system enables you to customize the name or label for any auxiliary audio input
at the control unit. Each input can be named from one of the preset input labels or can be user defined.

The SMART Audio configuration software Input Names/Trims tab enables you to do the following:

l Change the name an audio input so that it’s more recognizable in SMART Audio software.

l Set trims for audio inputs.
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Input names
Each input has a name that appears in the SMART Audio software volume controls.

g To change the name of an auxiliary audio input

1. Select the Input Names/Trims tab.

2. Identify the input you want to rename.

3. In the drop-down list, select the name you want for that input. If you select User Defined, type
a name for the input.

Input trim settings
You can trim the audio inputs that arrive at the control unit to reduce their volume.

g To change the trim of an auxiliary audio input device

1. Select the Input Names/Trims tab.

2. Select the input you want to trim, and then set the trim.

System settings
The SMART Audio ConfigurationSystem Settings tab enables you to do the following:

l Set Auto Select.

l Set a trigger for the roommodule relay.

l Set a response for the roommodule relay.

Setting Auto Select
When your SMART Audio system is set to Auto Select, the control unit automatically detects the
active audio input. This enables the user with amicrophone to change the volume of the active
auxiliary input device without changing the volume of the other auxiliary input device.

For more information on changing the volume of the auxiliary input with themicrophone, see page 17.

A PPEN D I X A

Customizing SMART Audio software with configuration software

48



g To set Auto Select

1. Select theSystem Settings tab.

2. Select theAuto Select checkbox to enable themicrophone to only change the volume of the
active audio input.

OR

Clear the checkbox to enable themicrophone to change the volume of all audio input devices.

Relay settings
You can install a relay at the roommodule to trigger a relay response on command, such as dimming
lights, turning on an auxiliary input or sending a signal to another location.

The command to the relay trigger can be one of the following:

l By the teacher pressing the soft button of themicrophone.

l By an input at the 6-12 VDC input.

l By either the soft button or by an input at the 6-12 VDC input.

The relay can provide one of the following:

l Latching response

l 200ms pulse

l 400ms pulse

l 600ms pulse

About the relay
This is an SPDT relay with Not Open (N.O.), Not Closed (N.C.) and COM settings.

Relay states
A relay can be in an activated or deactivated state, as shown below.

State Relay path

Activated The N.O. contact is closed and the N.C. contact is open.

Deactivated The N.O. contact is opened and the N.C. contact is closed.
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Room module connections
There are relevant connections on the roommodule.

PAGIN G
INPU T

6-12VDC
INPU T

NI NI

TO C U
RELAY

OUTPU T

N.C. N.O.COM

SMART Bus

Expansion
  Sensors

Relay connections6-12 VDC

g To set Relay Mode

1. Select theSystem Settings tab.

2. Select the preferredmode from the following table:

Setting Result

Latching Relay is active until the next pulse is received.

200ms pulse Relay is active for 200milliseconds.

400ms pulse Relay is active for 400milliseconds.

600ms pulse Relay is active for 600milliseconds.

g To set Relay Trigger

1. Select theSystem Settings tab.

2. ForRelay Trigger, select either for bothmicrophone soft button and 6-12 VDC input to trigger
the relay.

OR

Selectmic for microphone soft button only.

OR

Select 6–12v for 6-12 VDC input only.

N   NOTE

If you select 6-12v input as a relay trigger, the input can also duck audio volume on the same signal.
For more information, see page 43.
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Appendix B: Hardware environmental
compliance
SMART Technologies supports global efforts to ensure that electronic equipment is manufactured,
sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment
regulations (WEEE directive)
Waste Electrical and Electronic Equipment regulations apply to all electrical and electronic equipment
sold within the European Union.

When you dispose of any electrical or electronic equipment, including SMART Technologies
products, we strongly encourage you to properly recycle the electronic product when it has reached
end of its life. If you require further information, please contact your reseller or SMART Technologies
for information on which recycling agency to contact.

Restriction of Certain Hazardous Substances
(RoHS directive)
This product meets the requirements of the European Union’s Restriction of Certain Hazardous
Substances (RoHS) directive 2002/95/EC.

Consequently, this product also complies with other regulations that have arisen in various
geographical areas, and that reference the European Union’s RoHS directive.

Batteries
Batteries are regulated in many countries. Check with your reseller to find out how to recycle used
batteries.

There are special regulations that must bemet when shipping a product that has a lithium ion battery
packaged with the product or shipping a lithium ion battery. When returning a SMART Technologies
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product which contains a lithium ion battery or returning a lithium ion battery, call SMART
Technologies RMA for information on these special shipping regulations:

l 1.866.518.6791, Option 4 (U.S./Canada)

l 1.403.228.5940 (all other countries)

Packaging
Many countries have regulations restricting the use of certain heavy metals in product packaging. The
packaging used by SMART Technologies to ship products complies with applicable packaging laws.

Covered electronic devices
Many U.S. states classify monitors as covered electronic devices and regulate their disposal.
Applicable SMART Technologies products meet the requirements of the covered electronic devices
regulations.

China’s Electronic Information Products
regulations
China regulates products that are classified as EIP (Electronic Information Products). SMART
Technologies products fall under this classification andmeet the requirements for China’s EIP
regulations.

U.S.Consumer Product Safety Improvement Act
The United States has enacted theConsumer Product Safety Improvement Act which limits the lead
(Pb) content in products used by children. SMART Technologies is committed to complying with this
initiative.
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SMART Technologies

smarttech.com/support

smarttech.com/contactsupport

http://www.smarttech.com/support
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